
Microsoft Excel 100-Question Comprehensive Quiz (Raw Text Format) 

1. What is the default file extension for an Excel Workbook in modern versions 
(2007+)? 

A) .doc 

B) .xlst 

C) .xlsx 

D) .pptx 

Answer: C 

2. Which element displays the address (name) of the currently selected cell? 

A) Status Bar 

B) Formula Bar 

C) Name Box 

D) Title Bar 

Answer: C 

3. Which key combination is used to edit the contents of the currently selected 
cell? 

A) F1 

B) F4 

C) F2 

D) F7 

Answer: C 

4. What is the maximum number of rows available in a single worksheet in modern 
Excel? 

A) 65,536 

B) 1,048,576 

C) 1,048,576 

D) 16,384 

Answer: C 

5. Which symbol must precede a formula for Excel to calculate it? 



A) # 

B) ! 

C) & 

D) = 

Answer: D 

6. Which tab is typically used to insert charts, pivot tables, and pictures? 

A) Home 

B) Insert 

C) Data 

D) Review 

Answer: B 

7. The intersection of a row and a column in a worksheet is called a: 

A) Label 

B) Field 

C) Cell 

D) Record 

Answer: C 

8. Which Excel feature automatically completes data entry based on patterns in 
neighboring cells? 

A) AutoSum 

B) AutoCorrect 

C) Flash Fill 

D) Data Validation 

Answer: C 

9. What is the keyboard shortcut to move to the beginning of a row (Cell A1) from 
anywhere on the worksheet? 

A) Ctrl+End 

B) Ctrl+Shift+Home 

C) Ctrl+Home 



D) Alt+Home 

Answer: C 

10. Which function finds the largest value in a set of numbers? 

A) SUM 

B) MIN 

C) AVERAGE 

D) MAX 

Answer: D 

11. What is the correct way to write an absolute cell reference for cell B5? 

A) B5 

B) B$5$ 

C) $B5 

D) $B$5 

Answer: D 

12. If you copy the formula $=A1+B1$ from C1 to C2, the formula in C2 will be: 

A) $=A1+B1$ 

B) $=B1+C1$ 

C) $=A2+B2$ 

D) $=A1+B2$ 

Answer: C 

13. Which shortcut key is used to cycle through different types of cell references 
(Relative, Absolute, Mixed) when editing a formula? 

A) F1 

B) F3 

C) F4 

D) F5 

Answer: C 

14. A range of cells starting at A1 and ending at C5 is written as: 



A) A1-C5 

B) A1:C5, 

C) A1:C5 

D) (A1:C5) 

Answer: C 

15. How do you select an entire column in an Excel worksheet? 

A) Click the first cell and drag down 

B) Ctrl+Space 

C) Click the column letter header 

D) Shift+Space 

Answer: C 

16. What is a Named Range? 

A) The cell address 

B) A range that changes automatically 

C) A fixed range used for printing 

D) A user-defined name given to a cell or cell range 

Answer: D 

17. To select the entire worksheet using the keyboard, you press: 

A) Ctrl+A (once) 

B) Ctrl+Shift+Space 

C) Ctrl+A (twice) 

D) Ctrl+Shift+8 

Answer: C 

18. Which of the following is an example of a Mixed Reference? 

A) $A$1 

B) A1 

C) A$1$ or $A1 

D) Both C and D 



Answer: C 

19. Which character is used to separate the sheet name from the cell reference (e.g., 
Sheet1!A1)? 

A) / 

B) : 

C) ! 

D) # 

Answer: C 

20. The keyboard shortcut $Ctrl+Page Down$ is used to: 

A) Scroll down one page 

B) Move to the last cell 

C) Move to the next worksheet tab 

D) Move to the bottom of the current data region 

Answer: C 

21. The formula for adding up a range of numbers from A1 to A10 is: 

A) $=ADD(A1:A10)$ 

B) $=SUM(A1:A10)$ 

C) $=A1+A10$ 

D) $=TOTAL(A1:A10)$ 

Answer: B 

22. Which function calculates the number of cells in a range that are not empty? 

A) COUNT 

B) COUNTA 

C) COUNTBLANK 

D) COUNTIF 

Answer: B 

23. The IF function returns a value based on a specified: 

A) Range 



B) Formula 

C) Condition (Logical Test) 

D) Text string 

Answer: C 

24. The function that retrieves the current date and time (which updates 
automatically) is: 

A) DATE() 

B) TIME() 

C) TODAY() 

D) NOW() 

Answer: D 

25. Which function is used to convert text to all lowercase letters? 

A) UPPERT 

B) PROPER 

C) LOWER 

D) CHANGECASE 

Answer: C 

26. What does the function $COUNTA(A1:A5)$ return if A1=10, A2=hello, A3=, 
A4=true, A5=0? 

A) 3 

B) 4 

C) 5 

D) 1 

Answer: B 

27. Which function returns the remainder after a number is divided by a divisor? 

A) QUOTIENT 

B) DIVIDE 

C) MOD 

D) REMAINDER 



Answer: C 

28. The VLOOKUP function searches for a value in the: 

A) Last row 

B) First column 

C) Last column 

D) First row 

Answer: B 

29. To find the $n$-th largest value in a dataset, you would use which function? 

A) MAX 

B) LARGE 

C) RANK 

D) TOP 

Answer: B 

30. Which type of formula is entered into a cell and then applied to multiple cells 
using $Ctrl+Shift+Enter$? 

A) Standard Formula 

B) Array Formula 

C) Pivot Formula 

D) Named Formula 

Answer: B 

31. The LEFT function extracts characters starting from which side of a text string? 

A) Right 

B) Middle 

C) Bottom 

D) Left 

Answer: D 

32. What does the $TODAY()$ function return? 

A) Current time only 



B) Current date and time 

C) Current date only 

D) Current weekday 

Answer: C 

33. Which function combines two or more text strings into one? 

A) JOIN 

B) MERGE 

C) CONCATENATE 

D) TEXTJOIN 

Answer: C 

34. The ISNUMBER function is an example of what category of functions? 

A) Math 

B) Text 

C) Logical 

D) Financial 

Answer: C 

35. What is the purpose of the Absolute Value (ABS) function? 

A) Convert to a percentage 

B) Convert to integer 

C) Return the distance of a number from zero (non-negative) 

D) Return the reciprocal 

Answer: C 

36. The AVERAGEIF function calculates the average of a range based on a specified: 

A) Range 

B) Criteria 

C) Sum 

D) Formula 

Answer: B 



37. Which function is essential for creating nested conditional logic in Excel (e.g., 
grading scales)? 

A) IF 

B) IFS 

C) SWITCH 

D) VLOOKUP 

Answer: B 

38. The PMT function is primarily used for calculations in which domain? 

A) Statistical 

B) Date and Time 

C) Financial 

D) Engineering 

Answer: C 

39. Which function counts the number of cells that meet multiple criteria? 

A) COUNTIF 

B) COUNTIFS 

C) COUNT 

D) COUNTA 

Answer: B 

40. The INDEX function is often paired with which other function for advanced two-
way lookups? 

A) VLOOKUP 

B) MATCH 

C) OFFSET 

D) CHOOSE 

Answer: B 

41. The small black square at the bottom-right corner of an active cell is called the: 

A) Cell Pointer 

B) AutoComplete Box 



C) Fill Handle 

D) Name Box 

Answer: C 

42. Using the Fill Handle to drag a date (e.g., Jan 1) automatically increments the 
date. This is called: 

A) AutoFormat 

B) Flash Fill 

C) AutoFill 

D) AutoCorrect 

Answer: C 

43. Which feature is used to restrict the type of data or values that users can enter 
into a cell? 

A) Protect Sheet 

B) Data Validation 

C) Conditional Formatting 

D) Data Cleaning 

Answer: B 

44. Which tab on the Ribbon contains the tools for Goal Seek and Scenario 
Manager? 

A) Home 

B) Insert 

C) Data 

D) Formulas 

Answer: C 

45. Goal Seek is primarily used to find the necessary input value to achieve a 
specified: 

A) Scenario 

B) Trend 

C) Result (Output) 



D) Formula 

Answer: C 

46. Which feature lets you quickly clean and reshape data from multiple sources? 

A) Pivot Table 

B) Power Query 

C) Flash Fill 

D) Data Validation 

Answer: B 

47. The keyboard shortcut $Ctrl+D$ is used to copy the contents of the cell 
immediately above the active cell into the active cell. This is known as: 

A) Copy Down 

B) Flash Fill 

C) Fill Down 

D) AutoFill 

Answer: C 

48. What happens when you double-click the Fill Handle? 

A) Opens the Format Cells dialog 

B) Opens the Paste Special dialog 

C) Fills the formula/data down to the end of the adjacent data column 

D) Deletes the cell contents 

Answer: C 

49. Which tool allows you to forecast or back-calculate results based on a changing 
input cell? 

A) Goal Seek 

B) Data Validation 

C) Data Tables 

D) Scenario Manager 

Answer: C 



50. Which Excel feature automatically recognizes and extracts data patterns from 
adjacent columns without complex formulas? 

A) AutoSum 

B) AutoFill 

C) Flash Fill 

D) Data Validation 

Answer: C 

51. Which feature is used to change the formatting of a cell automatically based on 
its value (e.g., turning negative numbers red)? 

A) Cell Styles 

B) AutoFormat 

C) Conditional Formatting 

D) Custom Format 

Answer: C 

52. The default number format for a newly entered number in Excel is: 

A) Currency 

B) General 

C) Number 

D) Accounting 

Answer: B 

53. Which tab is used to quickly apply a predefined visual style (e.g., Bad, Good, 
Neutral) to cells? 

A) Insert 

B) Data 

C) Home (Styles Group) 

D) Design 

Answer: C 

54. The Format Painter tool copies what? 

A) Only the cell value 



B) Only the formula 

C) Only the cell formatting 

D) Both value and formatting 

Answer: C 

55. Which command is used to display the underlying formulas in cells instead of 
their calculated results? 

A) Ctrl+` (Accent Grave) 

B) Ctrl+F 

C) F2 

D) Alt+F11 

Answer: A 

56. The shortcut to apply the Currency format ($) to selected cells is: 

A) Ctrl+Shift+3 

B) Ctrl+Shift+4 

C) Ctrl+Shift+5 

D) Ctrl+Shift+7 

Answer: B 

57. What is a Custom Number Format primarily used for? 

A) Change the cell background color 

B) Change the cell value 

C) Change how the cell value is displayed without changing the value 

D) Create a data validation rule 

Answer: C 

58. To show a cell as a percentage with one decimal place, the custom format code 
is usually: 

A) $0.00\%$ 

B) $0.0\%$ 

C) $0\%$ 

D) $100\%$ 



Answer: B 

59. Which conditional formatting rule visually compares a range of values by using 
colored bars within each cell? 

A) Icon Sets 

B) Color Scales 

C) Data Bars 

D) Highlight Rules 

Answer: C 

60. The command to Merge and Center selected cells is found in which group on the 
Home tab? 

A) Font 

B) Styles 

C) Editing 

D) Alignment 

Answer: D 

61. A Sparkline is a small chart designed to fit within a single: 

A) Row 

B) Column 

C) Cell 

D) Worksheet 

Answer: C 

62. Which type of chart is best suited for showing the trend of data over time? 

A) Pie Chart 

B) Bar Chart 

C) Line Chart 

D) Scatter Plot 

Answer: C 

63. A Pie Chart is best used to display: 

A) Correlation between two variables 



B) Proportions of a whole 

C) Data trends over time 

D) Data ranking 

Answer: B 

64. Which keyboard shortcut inserts a new chart based on the selected data range 
(using the default chart type)? 

A) Ctrl+C 

B) Alt+F1 

C) F11 

D) Alt+C 

Answer: B 

65. What is the purpose of the Legend in a chart? 

A) To display the data source 

B) To identify the data series by color/pattern 

C) To show the overall trend 

D) To label the axes 

Answer: B 

66. Which chart element identifies the category names along the bottom of the 
chart? 

A) Value Axis 

B) Chart Title 

C) Legend 

D) Category Axis 

Answer: D 

67. To plot data points based on two numerical variables (showing correlation), you 
would use a: 

A) Line Chart 

B) Bar Chart 

C) Area Chart 



D) Scatter Chart (XY) 

Answer: D 

68. The Data Series in a chart refers to: 

A) The entire chart area 

B) The legend 

C) The set of data points plotted in the chart 

D) The chart title 

Answer: C 

69. Which tab becomes visible when you select a chart, allowing you to quickly 
change its layout and style? 

A) Insert 

B) Data 

C) Chart Design/Format 

D) Formulas 

Answer: C 

70. Which term describes a line or curve added to a chart to show the general 
direction of the data? 

A) Axis 

B) Trendline 

C) Data Label 

D) Sparkline 

Answer: B 

71. Which feature allows you to display only the rows that meet certain criteria, 
temporarily hiding the rest? 

A) Sort 

B) Filter 

C) Group 

D) Subtotal 

Answer: B 



72. A Pivot Table is primarily used to summarize, analyze, explore, and present large 
datasets by: 

A) Sorting them alphabetically 

B) Grouping and aggregating data 

C) Coloring specific cells 

D) Checking for errors 

Answer: B 

73. Where is the Data Tab's Sort & Filter group located? 

A) Home Tab 

B) Insert Tab 

C) Data Tab 

D) Review Tab 

Answer: C 

74. Applying a Custom Sort allows you to sort data using: 

A) Only one column 

B) Only Ascending/Descending order 

C) Multiple columns with specific rules 

D) Only numbers 

Answer: C 

75. The Subtotal tool automatically inserts aggregate functions (like SUM or COUNT) 
into a dataset based on: 

A) The whole sheet 

B) Hidden rows 

C) Changes in a designated column 

D) Conditional formatting 

Answer: C 

76. Which type of data is typically used in the Values area of a Pivot Table? 

A) Text labels 

B) Dates 



C) Numerical data (to be summed/counted) 

D) Formulas 

Answer: C 

77. The Remove Duplicates command is found on which tab? 

A) Home 

B) Insert 

C) Data 

D) Review 

Answer: C 

78. Which is the fastest way to format a raw table of data into a structured Excel 
Table object? 

A) Format Painter 

B) Conditional Formatting 

C) Ctrl+T 

D) Alt+F1 

Answer: C 

79. To display data in a logical hierarchy (e.g., year, then month), you would use: 

A) Subtotals 

B) Filters 

C) Grouping 

D) Sorting 

Answer: C 

80. Which is the correct sequence to apply a basic Filter? 

A) Insert > Filter 

B) Home > Filter 

C) Data > Filter 

D) Formulas > Filter 

Answer: C 



81. Which command prevents specific rows and/or columns from scrolling off the 
screen when viewing a large dataset? 

A) Hide/Unhide 

B) Protect Sheet 

C) Freeze Panes 

D) Split Window 

Answer: C 

82. To protect a sheet from editing by other users, the command is found on which 
tab? 

A) Home 

B) Insert 

C) Data 

D) Review 

Answer: D 

83. Which feature lets you view a separate section of the same worksheet by dividing 
the window horizontally or vertically? 

A) Freeze Panes 

B) New Window 

C) Split Window 

D) Hide/Unhide 

Answer: C 

84. Which element is specifically used to add notes or feedback to a cell for 
collaboration, appearing as a red triangle? 

A) Note 

B) Text Box 

C) Comment 

D) Data Validation 

Answer: C 



85. Which view shows where page breaks occur and allows you to adjust print 
areas? 

A) Print Preview 

B) Normal View 

C) Page Break Preview 

D) Custom View 

Answer: C 

86. The command to Hide a worksheet is found in the contextual menu (right-click) 
or the Cells group of which tab? 

A) Data 

B) Review 

C) Home 

D) View 

Answer: C 

87. The keyboard shortcut to insert a new sheet into the workbook is: 

A) Ctrl+N 

B) Ctrl+I 

C) Shift+F11 

D) Alt+N 

Answer: C 

88. To view two different workbooks side-by-side simultaneously, you use the View 
tab command: 

A) Freeze Panes 

B) Arrange All 

C) New Window 

D) Split Window 

Answer: B 

89. What is the primary purpose of the Document Inspector? 

A) Check formulas for errors 



B) Remove hidden data and personal information 

C) Check accessibility standards 

D) Review data trends 

Answer: B 

90. Which feature allows a user to create and save a specific set of display or print 
settings? 

A) Custom Format 

B) Custom View 

C) Conditional Formatting 

D) Split Window 

Answer: B 

91. A Macro is primarily used to: 

A) Format cells automatically 

B) Automate repetitive tasks 

C) Check cell errors 

D) Filter data 

Answer: B 

92. Macros are recorded and managed using the Macros group found on which tab 
(often hidden by default)? 

A) Home 

B) Formulas 

C) Data 

D) Developer 

Answer: D 

93. The keyboard shortcut to open the Visual Basic Editor (VBE) for macro coding is: 

A) Ctrl+F11 

B) Alt+F11 

C) Ctrl+Shift+E 

D) F12 



Answer: B 

94. What must an Array Formula (entered with $Ctrl+Shift+Enter$) be enclosed in? 

A) Parentheses ( ) 

B) Square brackets [ ] 

C) Curly braces { } 

D) Quotation marks " " 

Answer: C 

95. The Solver add-in is used for what type of advanced analysis? 

A) Data cleaning 

B) Financial modeling 

C) Optimization problems 

D) Statistical correlation 

Answer: C 

96. Which Excel error code indicates that a formula refers to an invalid cell? 

A) #NUM! 

B) #VALUE! 

C) #N/A! 

D) #REF! 

Answer: D 

97. The keyboard shortcut $Ctrl+;$ (semicolon) inserts the: 

A) Current time 

B) Current date and time 

C) Current date 

D) A semicolon 

Answer: C 

98. Which of the following is not a logical operator used in Excel formulas? 

A) = 

B) <> 



C) <= 

D) + 

Answer: D 

99. What does the LEN function return? 

A) The largest number in a range 

B) The list of unique values 

C) The number of characters in a text string 

D) The last digit of a number 

Answer: C 

100. Which Excel error code indicates that a number is too large or too small to 
be represented? 

A) #VALUE! 

B) #DIV/0! 

C) #NAME? 

D) #NUM! 

Answer: D 

 


